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So what’s new? 

 Simple and fast installation process 
• Toolkit and runtime part of same package 

• Components created and started when Toolkit is started first 

 

 MQ dependency removed but users are still allowed to use it as before 

 

 Enhanced WebUI for administration, viewing and managing components 

 

 Connecting to applications and devices using MQTT protocol 
• MQTTPublish and MQTTSubscribe nodes 

 

 Flexible Administration security  
• File-based and MQ-based 

 

 Shared libraries deployed independently of the referencing resources 

 

 Tutorials gallery and GitHub for downloading sample solutions 
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Supported Migration Paths 

 You can migrate to IBM Integration Bus Version 10.0 from the following 

previous versions:  

WebSphere® Message Broker Version 7.0.0.5 

WebSphere Message Broker Version 8.0 

 IBM Integration Bus Version 9.0 

 

 You must first ensure your MQ installation is at a supported version 

WMB V7.0.0.5 supports WMQ V7.0.1, V7.1.0.1, V7.5 

WMB V8.0 supports WMQ V7.0.1.6, V7.1.0.3 (requires V8.0.0.1), 

V7.5.0.1 (requires V8.0.0.1), V8.0 (requires V8.0.0.4) 

 IIB V9 supports WMQ V7.1.0.3 (requires V9.0.0.1), V7.5.0.1, V8.0 

(requires V9.0.0.2) 
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Co-existence 

 IIB V10 can coexist with IIB V9, WMB V8 and V7. 

Windows ® : 

Multiple instances of each of the versions (but different fixpacks) can be 

installed on the same system. 

UNIX ® es and z/OS ® : 

Multiple instances of each of the versions and fixpacks can be installed 

on the same system. 

  Ensure correct mqsiprofile is sourced before starting the Integration nodes 

to pick up the correct fixpack levels and versions. 

 Multiple versions of IIB Toolkit can be installed on the same machine 

You can not use IIB V10 Toolkit to connect to a V9 broker or vice versa 
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Working with WebSphere MQ 

 IIB V10 still integrates with MQ and provides seamless migration 

 On z/OS, MQ is required as before 

 On distributed, MQ is not a pre-requisite for IIB, but can be used 

Supported with MQ 7.1.0.4 (IV69571, IV70713); MQ 7.5.0.2 

(IV69571, IV70713); MQ 8.0 

 IIB V10 gives ability to configure local or client connection to qmgrs  

configure the connection properties on MQInput/Output/Get/Reply 

OR 

 -q flag on mqsicreatebroker / mqsichangebroker 

 You must configure MQ env for the integration node associated with MQ 
eg. . /opt/mqm/setmqenv -s -x 64 

 IBX superseded completely by WebAdmin UI 
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Working with WebSphere MQ 

    Nodes and capabilities that 

require the MQ Server to be 

installed on the same 

machine as Integration Node 

and the qmgr to be 

associated with it. 

Nodes Capabilities 

TimeoutControl node 

TimeoutNotification node 

SCAAsyncRequest node 

SCAAsyncResponse node 

SCAInput node 

SCAReply node 

SCARequest node 

AggregateControl node 

AggregateReply node 

AggregateRequest node 

Collector node 

Resequence node 

Sequence node 

SAPInput node 

SAPReply node 

SAPRequest node 

CDInput node 

CDOutput node 

FTEInput node 

FTEOutput node 

MQOptimizedFlow node 

Publication node 

Record and Replay 
 

High availability (for multi-instance 

and HTTP proxy servlet). 

 

Load balancing (Not applicable to 

embedded listeners) 

 

Accounting and statistics (Not 

applicable if  used with MQTT) 

 

Global Transactionality (requires all 

MQ nodes in a message flow to use 

the same qmgr) 

 

Administration security (Not 

applicable to file-based security) 

SYSTEM.BROKER.* queues 

are used for these features 
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Working with WebSphere MQ 

    Nodes and capabilities that do not require MQ qmgr to be associated with 

Integration Node. 

Nodes Capabilities 

JMSMQTransform node 
JMSMQTransform node 
MQHeader node 
MQGet node 
MQInput node 
MQOutput node 
MQReply node 

Publish and subscribe (only applicable 
to monitoring, operational, or 
administration events over WebSphere 
MQ as well as over MQTT) 

    If SSL is required, MQ nodes may be configured using broker-wide keystore  
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Working with WebSphere MQ 
 MQ nodes from same/different message flows in same/different 

Integration Nodes can access same/different qmgrs 

 Qmgr links are defined by policy/configurable services 

Different MQ topologies available:  

Local QM 

Int. 

Node  

Remote QM 

Int. Node 

Remote QM Remote QM 

Int. Node Int. Node Int. Node 

Remote QM 

1:1 1:Many Many:1 
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Migration Options 
In-place migration: 

 

Migrates existing broker and its components immediately to V10 

  

Should be performed on the same system where broker exists 

 

Requires stopping the broker / integration node 

 
Requires running the command: mqsimigratecomponents 
 

Provides –t option to roll back to previous state 

 

No support for 32-bit OS (Windows x86 and Linux® x86) 

 

Install V10 Stop broker 2 3 4 1 Run command Start Int. node 
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Migration Options 

Install V10 
Create new 

Int.node 
2 3 4 1 Deploy artifacts Stop old broker 

Parallel migration: 

 

Provides ability to migrate on same or a different system 

 

Does not overlap with the existing broker, so no need to stop the broker 

 

Create new Integration node and deploy artifacts to it 

If migrating from x86, use parallel migration and re-create the integration 

nodes from scratch 

Requires the Integration node / server properties and Administration security 

to be reconfigured on the newly created components 
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Migrating Toolkit resources 

 Message flow/set and Java™ projects can be exported from the earlier 

Toolkit version and imported into IIB V10 Toolkit before deployment 

 

 Export and Import the resources as Project Interchange to convert them to 

Integration projects 

 

 Convert the projects to applications or libraries by right-clicking the project: 

 Convert Single Project to convert a project with no references 

 Analyze and convert multiple projects to convert one or more projects 

and any referenced resources 
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Migrating Toolkit resources 

 If your message flow project contains old mapping nodes, schema, adapter 

components, WSDL files, IDL files, or SCA definitions 

 Convert .msgmap to .map 

 Some manual organization of migrated resources may be needed 

 

 The resources from IIB V10 Toolkit can not be used in the previous 

versions of Toolkit 

 
 Incase of any errors, check Window > Show View > Problems and 

right-click the message to apply Quick Fix  
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Migrating Toolkit resources 

 When migrating message flows that use SSLv3 protocol > change the 

protocol to TLS where appropriate (eg. SOAPRequest node property) 

 

 When migrating message flows that use JMS nodes > change the 

Transaction mode from Local, Global, None to Yes (with or without message 

flow Coordinated Transaction property or No 

 

 If WSDL and XML Schema information is to be made available to existing 
SOAPInput-SOAPReply flows > enable support for ?wsdl on SOAPInput 

WebSphere® Support Technical Exchange 14 



IBM Software Group 

Migrating Toolkit resources 

 For custom integration applications that use ConfigManagerProxy.jar file > 

Existing custom integration applications must be rebuilt to use the new 

IntegrationAPI.jar file, and the IntegrationAPI.jar file must be included in 

the class path for the applications 

 

 When migrating a message flow with SAP nodes > replace 32-bit Jco 

libraries with 64-bit and update Java build path 
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Web UI Administration 

 IBX is no longer provided as part of IIB V10 

 

 IIB Web UI is the primary means of runtime administration 

 Policy set configuration moved to IIB Toolkit 

 Export port configuration for external HTTP listeners in Web UI 

 Web UI allows Create / Rename / Delete of components 

 Web UI allows defining configurable services 

 Integration Server properties (JVM, Cache, Debug, FTE etc.) may be 

changed in Web UI 

 Web UI provides the ability to define operational ‘workload 

management policies that may be stored in Integration Registry 
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Pre-Migration steps 

Back up existing Resources: 

 Back up the ODBC files (odbc.ini, odbcinst.ini) and store them safely in 

a different location 

 Record the properties of all configurable services 

 Back up IIB/WMB Toolkit workspace and resources   

 Export all your projects from your current IIB / WMB Toolkit 

 Archive workspace resources: 

• If using a shared repository (eg. CVS) then follow standard backup 

procedures such as creating a version for storing V10 resources 

 

• When maintaining workspace resources on a local or shared disk 

then copy your workspace directory to a different location 
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Pre-Migration steps 
 Create ODBC definitions for DSNs and specify shipped database drivers 

• ODBC definiitions 

 Windows: ODBC Data Source Administrator window to change 

 Linux: odbcinst.ini and odbc.ini files. ODBC andODBCSYSINI 

environment variables 

• XA Resource Manager definitions  

 Windows: queue manager properties window using the 

WebSphere MQ Services snap-in 

 Linux: qm.ini file of the qmgr associated with the integration node 

 To validate the ODBC configuration is set up correctly, run the command: 
mqsicvp –n <DSN> -u <user> -p <password> 
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In Place Migration - distributed 
 Install IBM Integration Bus Version 10.0 on the same system as the 

current version in a new location 

 Stop all channels that are connected to the integration node 

 If any web browsers are connected to the Integration node, close the 

web UI and clear the browser cache 

 Stop the integration node by using the command mqsistop  

<integration node> 

 Set up the correct Version 10.0 command environment: 

• On UNIXes, open a new shell and run the environment profile 
mqsiprofile for V10 installation: 

. <iib install dir>/ server/bin/mqsiprofile 

• On Windows, open the IIB V10 Command Console with elevated 
privileges using:  mqsicommandconsole command 
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In Place Migration – distributed (cont) 
 Run the mqsimigratecomponents command to migrate the 

integration node. For example, mqsimigratecomponents IBNODE 

 If -u and -p options were specified with mqsicreatebroker 

command of old broker, these values are migrated with the integration 
node but may be changed using the command: mqsisetdbparms  

 Copy all additional custom environment settings from the original 

environment into V10 environment. For example, 
MQSI_FILENODES_ROOT_DIRECTORY 

 Run the command mqsichangebroker if qmgr association with the 

integration node needs removal after migration to V10. For example, 
mqsichangebroker IBNODE –q 

 

 Start the V10 integration node by using the command mqsistart 
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In Place Migration - z/OS 
 Stop all channels that are connected to the integration node 

 If any web browsers are connected to the web UI for the integration 

node, close the web UI window and clear the browser cache 

 Stop the integration node 

 Create a new PDSE with customized Version 10.0 JCL scripts, but stop 

before you deploy IBM Integration Bus 

 Customize and submit the BIPMGCMP (mqsimigratecomponents) job. 

This job migrates the registry and queue 

 Replace the Started Task JCL that is in the procedures library with the 

V10 Started Task JCL. 

 Start the V10 integration node. The verification program checks the 

configuration of the integration node 
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In Place Migration – Multi Instance 

 Install V10 onto each node in a new installation directory 

 Stop all channels that are connected to the integration node 

 If connected using web UI, close the web UI and clear the browser cache 

 Stop the integration node on first standby node and then active node 

 In an IIB V10 command console run the following command: 
mqsimigratecomponents <integrationNode> 

 Copy any additional custom environment settings from previous 

environment into IIB V10 environment. For example: 
MQSI_FILENODES_ROOT_DIRECTORY 

 On the active node first and then standby nodes, in an IIB V10 command 

console run the command: 

mqsistart <integrationNode> 
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Parallel Migration - distributed 

 Install IIB V10 on the same system as your existing version but in a 

different location, or on a different system  

 Migrate your development resources to the v10 Toolkit  

 Set up the correct V10 command environment: 

• On UNIXes, open a new shell and run the environment profile 
mqsiprofile for V10 installation 

• On Windows, open the Command Console for V10 installation 

 Create a V10 integration node using a name different from the 

existing integration node with or without a Qmgr 

 Start the V10 integration node using  
mqsistart <integration node> 
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Parallel Migration – distributed (cont) 

 Make a list of all existing integration servers and create these same 

servers on the v10 integration node 

 Deploy the existing resources to the Version 10.0 integration node 

from V10 Toolkit 

 Configure all other relevant properties of the existing integration 

node on the V10 integration node. 

Optional - Delete your existing integration node: 

 Stop the original integration node 

 Remove the original integration node from the Toolkit 

 Delete the original integration node 
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Post Migration 
 

 Review technical changes in IIB V10 

 Set up a command environment using mqsiprofile 

 Reconfigure any Integration node/server/ httplistener properties, 

configurable services etc.   

 Reconfigure Administration security after migration (queue-based or 

file-based) 

 Migrate deployable resources 
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Post Migration – Technical changes 
 

 V9 > V10 

 Improvements in DFDL schema validation 

 V8 > V10 

 XMLNSC timezone handling 

 V7 > V10 

 XMLNSC timezone handling 

 Resource statistics and message flow accounting and statistics 

XML publication messages 

 Refer to the following KC topic for details regarding technical changes 

in IIB V10 
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Post Migration – Command Environment Setup 

 

 Verify that you are running the correct profile before using v10 

  Log off and log on again before you run the specific profile that you 

require 

 Update environment variables to point to the correct locations of files 
like odbc.ini 

 Run the mqsicvp command to validate the connection to all data 

sources 
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Post Migration – Admin Security 

 

 

 Web UI should be used 

instead of IBX to view 

security profile 

information. Changes 

must be made using the 

command line or MQ 

Explorer if using mq 

authorizations. 

 

 No longer forced to use queue-based permissions on WebSphere MQ. 
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Post Migration – Deployable Resources 
 You can continue to use legacy resources in IIB however you will 

need to migrate these resources prior to continuing to develop them 

 Import message flow projects or integration projects into the V10 IIB 

Toolkit to migrate your resources from earlier versions 

 Message flow projects were replaced by Message Broker projects in 

WMB V8. Message Broker projects were renamed as integration 

projects in IIB V9 

 Resources that require additional steps 

 Message sets, Maps , ESQL files, Subflows, Message flows 

using SSLv3, Message flows that contain JMS nodes, File 

nodes, or wsdl queries, Custom integration applications, SAP 

adapter projects 
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Behavioral Changes 

 Web UI extended to support administration tasks (v9, v8, v7) 

• Web UI is extended to support integration node administration tasks 

 

 Additional options for administration security (v9, v8, v7) 

• IIB V10 provides the option of using file based permissions 

 

 Administration scripts may need to be updated (v9, v8, v7) 

• Some parameters for administration commands that connect to integration nodes have changed 

For example, mqsichangebroker with –q  
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Behavioral Changes 

 WebSphere MQ and migration to IIB V10 (v9, v8, v7) 

• MQ is no longer required for IIB to run, however there is still functionality that requires MQ to work as 

stated in the Knowledge Center  

 

  Message maps: change in behavior (v9, v8, v7) 

• The behavior of the Assign transform in the Graphical Data Mapping editor has been corrected when 

assigning an empty string to an element 

 Message flow statistics on z/OS (v9, v8, v7) 

• Additional fields have been added so that time intervals can be calculated correctly with web user 

interface. 
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Behavioral Changes 

 Web UI not enabled on migrated nodes (v8, v7) 

• The Web UI is not enabled on migrated integration nodes by default. New integration nodes 

have this enabled by default 

 Subflows and BAR files (v7) 

• BAR files are now built by packaging everything as source instead of compiling them into files 

like .cmf 

 Applications and Libraries (v7) 

• Existing projects can continue to be used however any newly created resources will fit the new 

Application and Libraries format  
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WESB -> IIB V10 
 Start the IBM Integration Toolkit. 

 Open the WebSphere ESB Import wizard  

 Click File > Import > Expand IBM Integration > 
Select WebSphere ESB Project Interchange > 

Click Next 

 

 

 Select a WebSphere Enterprise Service 

Bus PI file to import. 

 Optional: Select Launch WebSphere ESB 

conversion tool after import  

 Click Finish. 
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WESB → IIB V10 conversion tool 

Use WESB to IIB conversion tool to configure WebSphere ESB 

resource and global conversion options 
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Samples 

 Samples gallery replaced by the 

Tutorial gallery in the Help menu 

option in the Toolkit 

 

 

Opening the gallery provides a 

list of all the available tutorials 

stored in Github 

 

Note: This list will be updated 

regularly as more Tutorials are 

created by our developers 
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Samples 

Initial tab of the tutorial:  
Allows you to import the relevant 

working material, For example, message 

flows, maps, bar files, and other needed 

resources 
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Samples 
 Second tab provides 

details about the 

different components 

within the flow and 

describes how they 

will work 

 Final tab details how 

to run the sample to 

completion and 

review data to 

determine the 

success or failure of 

the test and helps 

with cleanup 
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Resources 

 Migrating to IIB V10 

 

 What’s new in IBM Integration Bus V10 

 

 Effective Administration in IIB V10 

 

 IBM Integration Bus in Cloud 

 

 IBM Integration Bus Community  

 

 IIB dwAnswers 
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Connect with us! 

 
1. Get notified on upcoming webcasts 

Send an e-mail to wsehelp@us.ibm.com with subject line “wste 

subscribe” to get a list of mailing lists and to subscribe 

2. Tell us what you want to learn 
Send us suggestions for future topics or improvements about our 

webcasts to wsehelp@us.ibm.com 
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Additional WebSphere Product Resources 

 Learn about upcoming WebSphere Support Technical Exchange webcasts, and access 
previously recorded presentations at:  
http://www.ibm.com/software/websphere/webcast 
 

 Discover the latest trends in WebSphere Technology and implementation, participate in 
technically-focused briefings, webcasts and podcasts at: 
http://www.ibm.com/developerworks/websphere/community/ 
 

 Join the Global WebSphere Community:  
http://www.websphereusergroup.org  
 

 Access key product show-me demos and tutorials by visiting IBM Education Assistant: 
http://www.ibm.com/software/info/education/assistant 
 

 View a webcast replay with step-by-step instructions for using the Service Request (SR) 
tool for submitting problems electronically: 
http://www.ibm.com/software/websphere/support/d2w.html 
 

 Sign up to receive weekly technical My Notifications emails: 
http://www.ibm.com/software/support/einfo.html 
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